
User Guide
v2.7

M852-9014-270

2015-06-25

VERTIGO XG INSIDE
VERTIGO XG & ITX INTEGRATION



i

Notices

Copyright and Trademark Notice
Copyright © 2015, Grass Valley USA, LLC. All rights reserved.

Belden, Belden Sending All The Right Signals, and the Belden logo are trademarks or 
registered trademarks of Belden Inc. or its affiliated companies in the United States and 
other jurisdictions. Grass Valley USA, LLC, Miranda, iTX, Vertigo XG Inside are trademarks or 
registered trademarks of Grass Valley USA, LLC. Belden Inc., Grass Valley USA, LLC, and other 
parties may also have trademark rights in other terms used herein.

Terms and Conditions
Please read the following terms and conditions carefully. By using iTX documentation, you 
agree to the following terms and conditions.

Grass Valley hereby grants permission and license to owners of iTXs to use their product 
manuals for their own internal business use. Manuals for Grass Valley products may not be 
reproduced or transmitted in any form or by any means, electronic or mechanical, including 
photocopying and recording, for any purpose unless specifically authorized in writing by 
Grass Valley.

A Grass Valley manual may have been revised to reflect changes made to the product 
during its manufacturing life. Thus, different versions of a manual may exist for any given 
product. Care should be taken to ensure that one obtains the proper manual version for a 
specific product serial number.

Information in this document is subject to change without notice and does not represent a 
commitment on the part of Grass Valley.

Warranty information is available in the Support section of the Grass Valley Web site 
(www.grassvalley.com).

Title Vertigo XG Inside User Guide

Software Version v2.7

Part Number M852-9014-270

Revision 2015-06-25, 15:36



Table of Contents
1 Integration of Vertigo XG and iTX. . . . . . . . . . . . . . . . . . . . . . . . 1
Overview of the XG Inside workflow. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Graphics preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Processing and playout of video and graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Limitations of the XG Inside. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3

Overview of the downstream Vertigo XG workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
Graphics preparation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5
Processing and playout of video and graphics . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2 Installing and Configuring XG Inside . . . . . . . . . . . . . . . . . . . . . 7
Setting up XG Inside for single channel playout. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

Installing ITXG Xmedia Suite Install on an iTX Output Server  . . . . . . . . . . . . . . . . . . . . 8
Establishing a connection between TX Play and Xplay . . . . . . . . . . . . . . . . . . . . . . . . . . 8
Adding an XG Inside device to the Xmedia Server’s Device Manager  . . . . . . . . . . . . 8
Enabling Auto-Publishing on the Templates, Pages and/or Scenes categories  . . . 9
Installing and configuring the VertigoXG desktop plugin  . . . . . . . . . . . . . . . . . . . . . .10

Setting up XG Inside for Dual Channel or Simulcast playout . . . . . . . . . . . . . . . . . . . . . . . .11
Setting up XG Inside for use with an external Vertigo XG . . . . . . . . . . . . . . . . . . . . . . . . . . .12

Configuring Xplay’s keyers. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .13
Configuring Xplay to use automation to control the Vertigo XG . . . . . . . . . . . . . . . .14
Configuring the Vertigo XG’s Dashboard settings for automation . . . . . . . . . . . . . .15

3 Using the Vertigo XG Plugin . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17
Vertigo XG Plugin overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18

Connecting the VertigoXG Viewer to the Xmedia Server . . . . . . . . . . . . . . . . . . . . . . .18
Unable to connect to the Xmedia Server?  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .19

Overview for creating an XG Event . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .20
Browsing or searching for templates, pages or scenes on an Xmedia Server  . . . . . . . .21
Creating a new page from a template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22
Adding a page to the VertigoXG palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .24
Opening and editing an existing page in the VertigoXG Viewer  . . . . . . . . . . . . . . . . . . . .24
Adding an unedited scene to the VertigoXG palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .25
Updating a scene already listed on the VertigoXG palette . . . . . . . . . . . . . . . . . . . . . . . . . .26
Creating a new scene based on an existing scene. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .27
Adding XG Events to an iTX schedule. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28

Adding an XG Event to the Schedule Grid . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28
Adding an XG Event to the Timeline. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .28

Editing the properties or content of a scheduled XG Event . . . . . . . . . . . . . . . . . . . . . . . . .29
ii



Table of Contents
Contact Us . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 31
iii



Integration of Vertigo XG and iTX
The branding capabilities of a typical iTX playout channel can be enhanced by integrating 
Vertigo graphics events into the iTX playout schedule. Using the VertigoXG plugin, Vertigo 
XG events can be added to the iTX Desktop’s schedule as secondary graphics events and 
then inserted into the iTX program stream either using:

• the XG Inside as an option that integrates the XG Renderer directly within iTX Output 
Servers and iTX Playout Appliances

or, 
• an external Grass Valley Vertigo XG device downstream of the iTX Output Server

Note: The integration of the Vertigo XG and iTX is supported by the 
following versions of the iTX and Vertigo Suite software: 

• iTX v2.7 or higher 
• Vertigo Suite v5.0 SP1 or higher

Summary
Overview of the XG Inside workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  2
Overview of the downstream Vertigo XG workflow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  4
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Overview of the XG Inside workflow
Overview of the XG Inside workflow
Figure 1-1 shows how iTX and the XG Inside components work together on an iTX Playout 
Server machine.

Fig. 1-1: XG Inside signal path and workflow

Graphics preparation
Vertigo templates are created offline using the Vertigo Suite’s Xstudio application. The 
templates provide the layout, formatting and optional logic for controlling the graphics 
during playout. An advantage of using graphics templates is that unique instances of the 
graphics can be quickly created by changing the content elements, without having to 
recreate the layout and formatting. See the Xstudio User Manual for more information about 
using Xstudio to create Vertigo templates.

Once a template is created, it is saved to a Vertigo Xmedia Server. From there, the template 
and its associated graphics files are published to the Embedded Xmedia Server (EXMS) on 
the iTX Playout Server, where they become available for playout. The Xpublish Agent puts 
the graphics files in the Scene folder.

The VertigoXG plugin associated with the iTX Desktop allows you to browse the templates 
and pages stored on the Xmedia Server. Opening the template in the plugin allows you to 
edit the content of the template and save it as a graphics page on the Xmedia Server. The 
Xmedia Server then publishes the page and its associated graphics files to the Embedded 
Xmedia Server (EXMS) on the iTX Playout Server. 

In addition to templates and pages, the VertigoXG plugin associated with the iTX Desktop 
also allows you to browse for standalone scenes stored on the Xmedia Server. Like the 
scene-side of a template, standalone scenes contain the collection of graphic objects that 
are displayed on air during playout. Standalone scenes are appropriate if the scene’s 
objects and playout do not require any control logic (static and/or timed playout). However, 
if the scene’s objects are to be data driven or controlled during playout, the scene should be 
associated with a template. See the Xstudio User Manual for more information about using 
Xstudio to create standalone scene assets.
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Processing and playout of video and graphics
Using the Vertigo XG plugin in the iTX Desktop, the graphics page and scenes can then be 
added to the channel’s schedule or timeline as a secondary event.

TX Play controls schedule playout by sending commands through the Output Server to the 
iTX Player to play out events at specified times. An event can feature one or two video 
sources, from which iTX produces an SDI or HD SDI output signal.

When an event includes a Vertigo page or scene, the iTX Player feeds the video streams to 
the XG Renderer. It always supplies two streams; if there is only one video source, one of the 
streams has blank frames.

Using the Oxtel protocol, TX Play instructs Vertigo Xplay to cue and take the page or scene. 
Xplay processes the page/scene requirements and sends playout commands to the 
XG Renderer.

The XG Renderer loads the page or scene and its associated graphics. The XG Renderer and 
the GPU renders the graphics with the video streams and passes a single rendered video 
stream back to the iTX Player, which combines this with the audio stream(s) for playout 
through the AJA video card.

The iTX Player does not pass any audio content to the XG Renderer. It disembeds the audio 
content from the video streams, diverts it around the XG Renderer and then re-embeds it 
into the rendered video stream (after a delay to compensate for the render process).

For events that do not feature a Vertigo page or scene (XG Event), the video streams simply 
pass through the XG Renderer (see Figure 1-2).

Fig. 1-2: For all other event types, the video streams pass through the XG Renderer

Limitations of the XG Inside
The following limitations currently apply to the integration of the Vertigo XG components 
in the iTX Output Server.

• The system can handle one or two video streams from any of the following source 
options: one video clip; two video clips; a live feed; a video clip and a live feed.
3
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• Cel animations are only supported if they are in the Grass Valley VAF format. 
Uncompressed TGA sequences are likely to have an adverse affect on the performance 
of the Output Server.

• The XG Renderer plays out audio clips embedded in a Vertigo XG template; but it does 
not perform any audio mixing with content from the iTX Player, since this contains no 
audio stream. This means that Vertigo templates cannot modify the audio properties 
(e.g. volume levels) of the clips played out by iTX.

• Audio-level reduction (ducking) and sound effects cannot be controlled from the 
XG Renderer.

• The XG Renderer does not modify any AFD code in the video streams.
• The XG Renderer does not include caption or subtitle data in the video stream it returns 

to the iTX Player.
• The XG Renderer cannot pass SNMP data to the iTX system.
• Where there is only one video stream and the source is a live feed, only transitions that 

do not involve overlapping video streams are possible (e.g. cut-cut; fade out, followed 
by fade in).

• Since the XG Renderer is responsible for the compositing of PGM A and PGM B video, 
traditional iTX functionality for squeeze-backs and picture-in-picture (PIP) effects do 
not work. 

Overview of the downstream Vertigo XG workflow
Figure 1-3 demonstrates that in a downstream branding model, the iTX Playout Server acts 
as an upstream video server, feeding video and audio content to the external Vertigo XG 
device. Meanwhile, graphics content is created and managed using the Vertigo Suite’s 
Xstudio and the Xmedia Server. iTX is the automation system that drives the playout 
schedule, including controlling the playout of graphics events from the Vertigo XG using 
Oxtel automation protocol commands.

Fig. 1-3: System diagram of an external Vertigo XG device downstream of an iTX system
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Graphics preparation
Vertigo templates are created offline using the Vertigo Suite’s Xstudio application. The 
templates provide the layout, formatting and optional logic for controlling the graphics 
during playout. An advantage of using graphics templates is that unique instances of the 
graphics can be quickly created by changing the content elements, without having to 
recreate the layout and formatting. See the Xstudio User Manual for more information about 
using Xstudio to create Vertigo templates.

Once a template is created, it is saved to a Vertigo Xmedia Server. From there, the template 
and its associated graphics files are published to the Embedded Xmedia Server (EXMS) on 
the Vertigo XG device, where they become available for playout. 

The VertigoXG plugin associated with the iTX Desktop allows users to browse the templates 
and pages stored on the Xmedia Server. Opening the template in the plugin allows users to 
edit the content of the template and save it as a graphics page on the Xmedia Server. The 
Xmedia Server then publishes the page and its associated graphics files to the Vertigo XG 
device. 

In addition to templates and pages, the VertigoXG plugin associated with the iTX Desktop 
also allows users to browse for standalone scenes stored on the Xmedia Server. Like the 
scene-side of a template, scenes contain the collection of graphic objects that will be 
displayed on air during playout. Standalone scenes are appropriate if the scene’s objects 
and playout do not require any control logic (static and/or timed playout). However, if the 
scene’s objects are to be data driven or controlled during playout, the scene should be 
associated with a template. See the Xstudio User Manual for more information about using 
Xstudio to create standalone scene assets.

Processing and playout of video and graphics
For system resilience, we recommend an independent control setup where the backup 
channel is configured to use a different Vertigo XG device and commands are always sent 
from both the Main and Backup channels regardless of which one is Master.

Fig. 1-4: Vertigo XG architecture

Using the Vertigo XG plugin in the iTX Desktop, graphics pages are added to the channel’s 
schedule or timeline as a secondary event.

TX Play controls schedule playout. It sends commands through the Playout Server to the 
iTX Player to play out events at specified times. An event can feature one or two video 
sources, from which iTX produces an SDI or HD SDI output signal. The output signal is then 
fed to the Vertigo XG device’s input.
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Processing and playout of video and graphics
When an XG event (Vertigo page or scene) is encountered in the schedule, TX Play uses the 
Oxtel protocol to instruct the Vertigo XG’s Xplay to cue and take the page or scene. Xplay 
processes the page requirements and sends playout commands to the XG Renderer.

The XG Renderer loads the page/scene and its associated graphics. The XG Renderer and 
the GPU renders the graphics with the video streams and outputs a single rendered video 
stream to air.

For events that do not feature a Vertigo page or scene (XG Event), the video streams simply 
pass through the Vertigo XG.
6



Installing and Configuring XG Inside
This chapter provides information and instructions for how to add and setup the XG Inside 
option on an iTX Output Server or iTX Playout Appliance. Instructions are also provided for 
how to configure a system that uses an external Vertigo XG downstream from an iTX 
Output Server.

Note: The scope of this chapter does not include hardware installation, 
cabling and other system-level installation and configuration information 
and instructions. We recommend that you consult the Vertigo XG, Xmedia 
Server and iTX system installation and configuration documentation before 
attempting to configure your system for the integration of XG branding 
within an iTX system.

Summary
Setting up XG Inside for single channel playout  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  7
Setting up XG Inside for Dual Channel or Simulcast playout  . . . . . . . . . . . . . . . . . . . . . . . . . . .  11
Setting up XG Inside for use with an external Vertigo XG . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  12

Setting up XG Inside for single channel playout
The following procedure identifies the tasks for installing and configuring the software 
components required for using the XG Inside option on a single channel iTX Output Server 
or iTX Playout Appliance.

To install and configure XG Inside for a single iTX playout channel:
1 Install the ITXG Xmedia Suite Install software component on the iTX Output Server 

(page 8).

IMPORTANT
This task should only be performed on iTX Output Servers. Proceed to the 
next task if you are configuring XG Inside on a iTX Playout Appliance since 
the software component is factory-installed on iTX Playout Appliances.

2 Establish the connection between TX Play and Xplay (page 8).
3 Add the XG Inside device to the Xmedia Server’s Vertigo Device Manager (page 8).
4 Enable auto-publishing on the Xmedia Server’s Templates, Pages and/or Scenes asset 

categories (page 9).
5 Install and configure the Vertigo ITX Desktop plugin on the client machine hosting the 

iTX Desktop application (page 10).
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Installing ITXG Xmedia Suite Install on an iTX Output Server
The Vertigo Suite Installer’s ITXG Xmedia Suite Install software preset contains the 
XG Renderer and its associated components and must be added to the iTX Output Server.

Note: The ITXG Xmedia Suite Install software component is factory-
installed on all iTX Playout Appliance - Single channel devices and 
Playout Appliance 2 devices. If you are adding and configuring the XG 
Inside option on an iTX Playout Appliance unit, do not reinstall it. Proceed 
to the next task in this configuration procedure. 

To add the ITXG Xmedia Suite Install component to an iTX Output Server: 
1 Ensure the iTX Server Controller is not running.
2 Acquire and run the latest version of the Vertigo Suite Installer.
3 When the installation wizard requests you to select components, select the ITXG 

Xmedia Suite Install preset configuration.
4 Follow the on screen instructions and install all dependencies.
5 Restart the iTX Output Server machine when the wizard prompts you to.

The wizard takes a few minutes to complete the installation after the (final) restart.

Establishing a connection between TX Play and Xplay
TX Play controls the channel’s schedule playout. So when TX Play encounters an XG event 
(graphics event) in the schedule, it communicates with Vertigo’s Xplay using the Oxtel 
protocol to instruct Xplay to cue and take the page.

To establish a connection between TX Play and Xplay:
1 Open the iTX Channel Config dialog box by double-clicking the TX Play Config or TX 

Play 2 Config desktop icon.
2 Enable the Integrated XG setting.
3 Click Save.

Adding an XG Inside device to the Xmedia Server’s Device Manager
For the Xmedia Server to publish assets to the Embedded Xmedia Server (EXMS) on the iTX 
Output Server, you must add an XG Inside device configuration profile to the Xmedia 
Server’s Device Manager. 

To add the XG Inside device to the Xmedia Server’s Device Manager:
1 Open Xstudio on a client machine and ensure that it is connected to the Xmedia Server.
2 Select the Tools>Device Manager menu command. 

The Device Manager window (Device Configuration) opens. 
3 Select the Add button in the lower-left corner.

The Device Configuration section (lower portion) immediately changes to become the 
Add Device Information section.

4 Complete the fields to create a device configuration profile for the XG Inside device.
• Provide a Name, Alias and Description for the device (e.g. XGInside)
8
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• Set the Device Type to VertigoXG.
• Set the Control IP to the IP address of the iTX Output Server hosting the XG Inside 

software components.
• Set the Control Port to 4000.

5 Click Apply and then Close.

Enabling Auto-Publishing on the Templates, Pages and/or Scenes 
categories

To increase workflow efficiency and accuracy, we recommend that you set auto-publishing 
on the Xmedia Server’s Templates, Pages and/or Scenes asset categories. This authorizes 
the Xmedia Server to automatically publish new or saved templates, pages and/or scenes 
from the Xmedia Server to the EXMS on the iTX Output Server.

Note: You do not have to set auto-publishing for other asset types. If a 
template, page or scene uses an asset of another type (i.e. images or clips), 
the asset will be automatically published as part of the 
template/page/scene.

To set-up auto-publishing on the Templates, Pages and/or Scenes categories:
1 Open Xstudio on a client computer that is connected to the Xmedia Server.
2 Open the Asset Browser.
3 Right-click the Templates root category and select the Properties command.

If you only want to auto-publish the contents of a sub-folder (rather than the root 
folder), simply navigate to the subfolder and right-click and select the Properties 
command.

4 Enable the output server(s) in the Category Properties window for which you want to 
be the recipients of the published assets (e.g. XGInside). Then click OK.

5 Repeat steps 3 and 4 for the Pages category and/or Scenes category.

Note: If your system has multiple output servers and you do not want to 
publish all of the contents to all of the devices, create matching 
subcategories under both the Templates and Pages root categories, as 
well as the Scene root category, and then assign the different categories 
to different devices. 
9
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Installing and configuring the VertigoXG desktop plugin
The VertigoXG plugin is an iTX channel plugin that allows the scheduling of secondary 
graphics events that are inserted into the iTX Program stream by the XG Inside option 
installed on an iTX Playout Server. 

This plugin adds the VertigoXG palette to the Content Selector on the Channel Control 
layout, which lets you create graphics pages based on Vertigo templates and then add the 
pages and/or scenes to the schedule or timeline. See Adding XG Events to an iTX schedule, 
on page 28 for more information.

IMPORTANT
To operate, the VertigoXG plugin requires that an iTX Integrated XG license 
be installed on the iTX Framework Server.

The following procedure assumes that you have already set up the channel configurations 
in the iTX Desktop. 

To install and configure the Vertigo XG plugin on a machine hosting iTX Desktop:
1 Acquire and run the latest Vertigo Suite installer on the computer hosting the iTX 

Desktop that is connected to the iTX Playout Server with XG Inside.
2 When prompted by the installation wizard, select to install the Vertigo iTX Desktop 

Plugin.
3 Follow the wizard instructions and respond to the prompts to install all dependencies.
4 Restart the computer when the wizard prompts you to.

The wizard takes a few minutes to complete the installation after the (final) restart.

To configure the VertigoXG Plugin for XG Inside operation:
1 In the iTX Desktop, select the Engineering>Channel Configuration view.
2 Select the channel.
3 Select the Plugins>VertigoXG tab and click the Active button to enable the Vertigo XG 

plugin. 
The Active button is a toggle for enabling (green LED) or disabling (grey LED) the 
Vertigo XG plugin.

4 Complete the following settings to associate the Vertigo XG plugin with the playout 
server:

Field Description

Address Enter the IP address of the playout server on which Xplay is 
running.

Port 5006 is the port number on which iTX is to communicate with 
Xplay.

Output Channel Currently not used.

Enable Slave Device Enable this setting when a Master-Slave setup is used and the 
Master and Slave each have their own instance of an XG.
If the Master-Slave channels share an instance of XG Inside, do 
not enable this setting on either of the channels. iTX will control 
the XG Inside system through TxPlay in the main channel only.
10
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5 Configure the following settings to ensure the internal timing of XG events and 
automation commands:

Field Description

Automation Delay 
(ms)

To ensure frame accuracy when using timestamps, iTX uses this 
value to determine how much earlier than the scheduled time 
Take and Clear commands should be sent. 
The default value of 500 ms should be sufficient when using 
XG Inside an iTX. If you still experience a latency, increase the 
value until it is resolved.

Enable TS Commands
(XG Inside only)

When selected, the Take and Clear commands are sent to the XG 
as determined by the Automation Delay (ms) setting with a 
timestamp indicating when the command will execute. 
This approach compensates for small delays in communication 
with the XG and ensures frame accuracy.

OFF Delay (frames) Specifies the number of frames prior to the end of the XG event 
that the Clear command will be triggered, so as to offer the 
page’s Default Out animation a chance to playout.
Although the default value is 0 frames, you must set this value 
to match the duration of the template’s Default Out animation.
NOTE: Since the OFF Delay value is fixed, all of your XG graphics 
templates must have the identical duration value for their 
Default Out animation. Otherwise, the animation may play 
beyond the XG event’s duration.

6 Click Save and then Close.

Setting up XG Inside for Dual Channel or Simulcast playout
The following procedure identifies the tasks for installing and configuring the XG Inside 
option for dual channel (two independent channels) or simulcast (two channels sharing 
two inputs) playout on an iTX Playout Appliance 2.

Prerequisites
• Ensure that the following software is installed on the iTX Playout Appliance 2:

• iTX v2.6 or later
• Vertigo Suite v5.0 SP1or later (ITXG Xmedia Suite Install component)

• As a precaution, create a back up of the SQL database (EXMS) using the SQL 
Management Studio’s Back-up menu command.

To install and configure XG Inside for dual channel or simulcast playout:
1 Close the iTX Service Controller window to stop all iTX services.
2 Double-click the TX Play 2 Config desktop icon to open the iTX Channel Config 

window.
3 Select either Dual Channel or Simulcast from the Playout Type drop-down list.
4 Provide a name for the first channel in the Root Name field.
5 Click the Add Channel button to add the second channel.
11
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• If Dual Channel, type a channel name in the New Channel Root Name field that is 
different than the first channel’s name and click OK.

• If Simulcast, type the same name as the first channel’s name in the New Channel 
Root Name field, enable the Simulcast check box and click OK.

6 Enable the Integrated XG check box for both channels.
a Select the first channel from the Channel Name drop-down list and enable the 

Integrated XG check box.
b Select the second channel from the Channel Name drop-down list and enable the 

Integrated XG check box.
c Click Save.

7 Open the iTX Server Controller Configuration window and verify that:
• Two Xplay services are listed; one suffixed for the first channel and the other 

suffixed for the second channel.
• Two Output Server services are listed; one whose parameter includes -id A for the 

first channel and -id B for the second channel.
8 Enable auto-publishing on the Xmedia Server’s Templates, Pages and/or Scenes asset 

categories (page 9).
9 Install and configure the “Vertigo ITX Desktop plugin” on the client machine hosting 

the iTX Desktop application (page 10).

Setting up XG Inside for use with an external Vertigo XG
The following procedure provides instructions for installing and configuring the software 
components required to integrate iTX as an automation system driving the downstream 
Vertigo XG device. The Vertigo XG device’s components must be configured to receive the 
program stream from the iTX Output Server and apply branding graphics as dictated by the 
iTX schedule before brought on air.

The iTX system and Vertigo system are setup and configured as they always are for a typical 
playout channel. As such, we recommend that you consult the iTX System Administrator 
Guide and the Vertigo Suite documentation for system installation and setup procedures.

To configure external Vertigo XG for iTX:
1 Configure Xplay’s interface for multiple keyers and assign the Vertigo XG’s localhost 

device (XG_CHA) to each keyer (page 13).
2 Configure Xplay’s Automation settings and the automation protocol for the Vertigo XG 

device (page 8).
3 Add the Vertigo XG device to the central Xmedia Server’s Device Manager (page 8).
4 Configure the Vertigo XG’s Dashboard settings for automation (page 15).
5 Enable auto-publishing on the Xmedia Server’s Templates, Pages and/or Scenes asset 

categories (page 9).
6 Install and configure the “Vertigo ITX Desktop plugin” on the client machine hosting 

the iTX Desktop application (page 10).
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Configuring Xplay’s keyers
When Vertigo XG units are factory-configured, a local XG_CHA device (XG_CHA and 
XG_CHB for dual channel devices) is defined in the Embedded Xmedia Server’s (EXMS) 
Device Manager. Sometimes known as the localhost device, the XG_CHA device represents 
the actual Vertigo XG output channel.

The following procedures provide instructions for configuring Xplay’s interface so that it 
can accommodate the independent control of the multiple keyers required to playout 
graphics on different layers on the playout channel. Once the keyers appear in Xplay, you 
can then assign the XG_CHA device to each of Xplay’s keyers and put the keyers in a ready 
state for playout.

To configure Xplay’s interface for multiple keyers:
1 Open Xplay and select Tools>Settings>General and set the Layout setting to Multi-

Device.
2 In the Number of devices setting, specify the number of Vertigo XG keyers to be 

controlled by the iTX automation system. For this example, we use 9 keyers.
3 Select Tools>Settings>Layout and set the Multi-Device Layout setting to 

PreviewOnAir.
4 Click OK and then restart Xplay.

When Xplay reopens it displays multiple Keyer windows along the right-side.

To assign the Vertigo XG’s XG_CHA device to each of Xplay’s keyers and put the keyers in 
a ready state:

1 With Xplay open, select the Tools>Devices Manager menu command. 
The Device Manager window (Device Configuration) opens with the XG_CHA device 
already listed in the table on the left-side.

2 In the right-side table in the Device Manager, click a <Device#> in the Name column to 
select the row.

3 Select the XG_CHA device (left table).
4 Click the right-arrow button .

The XG_CHA device is immediately added to the table on the right. It is also added to 
the Keyer on the Xplay interface.

5 Repeat the steps 2 - 4 for each of the <Device#> in the table.

6 Click Close. The local device (XG_CHA) device is now associated with each keyer in 
Xplay.

7 Ensure that the Vertigo XG device is actively connected to Xplay. 
13
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As shown above, when Xplay is connected to the device, the LED is green. If Xplay is 
disconnected from the device, then the LED is red.
To reconnect Xplay to the Vertigo XG device, simply double-click the red LED. If the 
connection isn’t immediately established, verify that the device is powered up and that 
the network is operating normally.

8 All of the keyers should be turned on, which is indicated by the background of the 
keyer’s Device name being pink. If the background is grey, then the keyer is turned off. 
To turn the keyer on, right-click on the keyer’s Device name and select the Turn Keyer 
On command.

Configuring Xplay to use automation to control the Vertigo XG
TX Play controls the channel’s schedule playout. So when TX Play encounters an XG event 
(graphics event) in the schedule, it communicates with the Vertigo XG device’s Xplay using 
the Oxtel automation protocol to instruct Xplay to cue and take the page or scene. To 
ensure proper communication between TX Play and Xplay, you must set Xplay’s 
Automation settings and configure Xplay to use the Oxtel protocol over TCP/IP.

To configure Xplay’s Automation settings: 
1 Select the Tools>Settings>Xplay>Automation to display Xplay’s Automation settings.
2 Enable the Automation (No Message boxes) setting, which overrides the behavior of 

the four settings below it and prevents message boxes from appearing during Xplay 
operations.

3 Leave the Deadband setting set to its default value.
4 Select from the TV Format setting’s drop-down list the target TV format for the 

execution of automation commands and page creation. This is used to determine the 
number of frames per second and to display timecode values. This TV Format should 
match the TV Format of the templates that you build and the Rendering Resolution 
setting of the Vertigo XG device (see Configuring the Vertigo XG’s Dashboard settings 
for automation, on page 15.

5 Click OK.

To configure Xplay to communicate with TX Play using the Oxtel protocol over TCP/IP:
1 Open Xplay’s Automation Configuration window and create an instance of the Oxtel 

protocol for the Vertigo XG’s local device (XG_CHA) that is to be controlled by TX Play. 
a Select Tools>Configure Automation.

The Xplay Automation Configuration window appears.
b In the Device to protocol mappings section, click the Add Protocol button next to 

the XG_CHA device.
c Select Oxtel over TCP/IP from the drop-down list that appears and press Enter. 

Leave the Properties settings in their default state.
2 Click OK and restart Xplay.
3 Verify that the automation configuration has been applied to the Xplay device(s).

Once Xplay has been restarted, the keyers that have been configured for automation 
should now display the automation indicator  in the keyer’s toolbar. If there is no 
communication between the automation system and Xplay, the automation indicator 
14
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remains grey. However, when communication between the TX Play and Xplay is 
established, the automation indicator is displayed in blue.

Configuring the Vertigo XG’s Dashboard settings for automation
There are a few settings in the Vertigo XG’s Dashboard that must be configured to 
synchronize the Vertigo XG’s rendering services with the video coming from the iTX Output 
Server, as well as to allow iTX automation to control the Vertigo XG.

The following procedure instructs you how to set the Vertigo XG’s Automation settings:

To configure the Vertigo XG’s Automation settings:
1 Open the Vertigo XG’s Dashboard application by selecting the Tools>Launch 

Dashboard command from the Vertigo XG’s Control Panel, which should already be 
open on the Vertigo XG’s desktop.

2 Select the Vertigo XG device from the Device Discovery table. If the device does not 
appear in the table, perform a Device Discovery (Tools>Settings>Device Discovery).

3 With the Settings Mode still set to Simple, ensure that the Output Resolution setting is 
the same as the TV Format setting in the Xplay Automation settings (page 14).

4 Change the Settings Mode by selecting Advanced from the drop-down list.
5 On the Hardware>Genlock page, set the Genlock settings particular to your iTX 

system.
6 Click the Apply Changes button and close the Dashboard application.
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Using the Vertigo XG Plugin
Within the iTX Desktop, the VertigoXG plugin provides operators with access to Vertigo 
templates, pages and scenes stored on the Xmedia Server directly from within the iTX 
Desktop application. Operators can create a new page based on a template or open an 
existing page or scene for editing. The Vertigo graphics pages and scenes can then be 
added to the iTX channel’s Schedule Grid or Timeline as secondary graphics events (XG 
type).

Summary
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Vertigo XG Plugin overview
The VertigoXG plugin adds the VertigoXG palette to the Content Selector on the iTX 
Channel Control layout. The palette features two buttons (Add Page and Remove Page) 
and a selection pane.

Fig. 3-1: The VertigoXG palette in the iTX Desktop’s Content Selector

Note: The VertigoXG Palette uses the term “Page” for both Vertigo pages 
and scenes. For example, the Selection pane lists both pages and scenes, but 
the column heading is Page Name. 

Clicking the Add Page button on the VertigoXG Palette opens the VertigoXG Viewer, which 
has two views: Browse and Edit. 

• Browse view allows you to browse and/or search for templates, pages and/or scenes 
that currently exist on a specified Xmedia Server. See Browsing or searching for 
templates, pages or scenes on an Xmedia Server, on page 21 for more information.

• Edit view allows you to create a new page based on a template or open an existing 
page or scene for editing. You can then save the page or edited scene to the Xmedia 
Server and add the page/scene to the VertigoXG Palette’s selection pane so that it can 
be added to the iTX schedule as an XG graphics event. 

Connecting the VertigoXG Viewer to the Xmedia Server
The first time the VertigoXG Viewer is opened, you must set the IP address of the Xmedia 
Server in the Hostname/IP field of the Settings window. This allows the VertigoXG Viewer 
to access the templates, pages and scenes of a particular Xmedia Server device, as well as 
save new pages and scenes to the Xmedia Server. 
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Unable to connect to the Xmedia Server?
Each time the VertigoXG Viewer is opened, it verifies the connection to the Xmedia Server. 
An error message appears if the VertigoXG Viewer is unable to connect to the Xmedia 
Server. 

To verify the current server settings:
1 Right-click the blue upper menu bar and select Change Settings. 

The Settings window appears and displays the current settings. 
• If the server settings are correct, verify that the Xmedia Server or network are 

working properly. 
• If the server settings are incorrect, edit the required fields and click OK. 

A message informs you that you must restart the client for the server settings 
changes to take effect. 
Close the VertigoXG Viewer and then reopen it.
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Overview for creating an XG Event
The following flowchart and the remaining sections of this chapter provide you with 
instructions for how to use the VertigoXG Palette and VertigoXG Viewer to create Vertigo 
graphics pages, edit pages and scenes and then add them to the iTX channel’s Schedule 
Grid or Timeline as secondary graphics events. 
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Browsing or searching for templates, pages or scenes on an Xmedia 
Server

The VertigoXG Viewer’s Browse view allows you to explore and display the template, page 
and scene assets currently stored on the specified Xmedia Server.

Use the Asset Browser to navigate through the Xmedia Server’s Templates, Pages and 
Scenes categories, as well as their sub-categories. The contents of a selected category are 
displayed in the pane to the right of the Asset Browser. 

The graphic below demonstrates that the selected category’s assets can be displayed two 
view types, which is determined by the Change the view  setting in the toolbar:

• Detail View: Displays the category’s assets in a detailed list.
• Proxy View: Displays the category’s assets as thumbnail images.

The Startup View setting in the VertigoXG Viewer’s Preferences settings determines which 
view is used when the VertigoXG Viewer is initially opened in Browse view.

Fig. 3-2: Template, page and scene assets stored on the XMS can be displayed in Proxy or Detail View

Double-clicking the template, page or scene asset opens in the template/page/scene in the 
VertigoXG Viewer’s Edit view.

If the VertigoXG Viewer opens in Edit view, you can switch to browse view by clicking the 
Create new  toolbar button.

Another method for exploring and accessing template, page and scene assets stored on the 
specified Xmedia Server is to use the Search tool. The Search tool allows you build a search 
query based on asset properties like name, author or a date range. When a query is 
performed, the Search tool returns a list of the assets that match the search conditions. Like 
the VertigoXG Viewer’s Browse view, the Search tool can display the results in Proxy View or 
Detail View.

Double-clicking the template, page or scene asset in the Search tool’s results pane opens 
the template/page/scene in the VertigoXG Viewer’s Edit view.

Although the Search tool can search and locate all asset types, only template, page and 
scene assets can be opened in the VertigoXG Viewer.
21



Using the Vertigo XG Plugin
Creating a new page from a template
Creating a new page from a template
The Vertigo Suite workflow dictates that templates are created in Xstudio. Templates are 
designed so that the formatting, layout and some graphical elements are fixed (i.e. cannot 
be edited except in Xstudio). 

In the XG & iTX integrated workflow, unique instances of the graphics, known as pages, can 
quickly and easily be created using the VertigoXG Viewer by changing dynamic content 
fields and saving the individual page asset. 

Note: While pages already exist on the Xmedia Server, you cannot create a 
new page from an existing page. In other words, there is no “Save Page As” 
functionality in the VertigoXG Viewer. You can only edit and save existing 
pages or create new pages from templates.

Fig. 3-3: Create a new page based on an existing template

To create a new page in the VertigoXG Viewer:
1 Open the template in the VertigoXG Viewer’s Edit view.
2 Edit the template’s dynamic fields. 

For example, you may be able to edit text fields, make selections from a drop-down list, 
or substitute an image, cel animation or clip asset displayed on the template.
To substitute an image, cel animation or clip element on a template, right-click on the 
element. A browser for that asset type appears and displays the assets on the Xmedia 
Server that can be used as substitutes. Select a new asset and click OK to add it to the 
template.

3 In the Duration field, specify the page’s default duration. 
The Duration setting in the VertigoXG Viewer is a property of the page and is therefore 
saved to the Xmedia Server with the page.
When the page is first added to an XG event, the page’s default duration value is used 
to set the initial duration for an XG event. The XG event’s duration value can then be 
edited independently of the page’s default Duration value. In other words, changing 
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the Duration value of an XG event does not change the page asset’s default Duration 
value, and vice versa.

Note: If the duration is set to 00:00:00, iTX imposes a default duration of 5 
seconds when the page is added to a schedule as an XG event.

4 Set the Trigger or Duration mode, which represents the default method by which the 
graphics page will be cleared when it is part of an XG event. 

• Trigger: The XG event will remain on air until another page replaces it or it is 
cleared in another manner (e.g. cleared using Xplay).

• Duration: The XG event will be cleared when its duration expires.
These modes are a property of the XG event in iTX, not the page asset itself in the 
Xmedia Server. Their settings are saved to the page element added to the VertigoXG 
Palette, but they are not saved as part of the page asset on the Xmedia Server.
When creating a new page, specify the default setting that will be used as the initial 
value when the page is added as an XG event. After the page reference has been added 
to the VertigoXG Palette, you can edit the default value by opening and editing these 
fields in the VertigoXG Viewer and then clicking the Save Page button. When the page 
is added to an XG event, the default value is used, but you can change it using the 
Event Editor.

5 In the Keyer setting, specify the default keyer that the page will playout on. 
This value is used when the page is added to the VertigoXG Palette, as well as when 
adding an XG event in the schedule/timeline. 
Note that this field is a property of the XG event, not the page asset itself. As such, the 
setting is saved to the page reference added to the VertigoXG Palette, but it is not 
saved as part of the page asset on the Xmedia Server. 
When creating a new page, specify the default keyer setting that will be used as the 
initial value when the page is added as an XG event. After the page has been added to 
the VertigoXG Palette, you can edit the default value by opening and editing the page 
in the VertigoXG Viewer and then clicking the Save Page button. When the page is 
added to an XG event, the default value is used, but you can change it using the Event 
Editor.

6 Click the Save Page button. 
The Save Page button creates the new page, saves the page to the Xmedia Server and 
adds a reference to the page element on the VertigoXG Palette’s Selection pane.

• Page name: The new page is automatically given a unique name, which consists of 
the template’s AutoName property (which defaults to the template’s name) with a 
timestamp appended. You cannot rename the page using the VertigoXG Viewer.

• Pages Category: The VertigoXG Viewer looks for a category under the Pages root 
category that has the same name as the category under the Templates root 
category from which the template originated. If such a category is found, then the 
Page is saved there. Otherwise, the page is saved in the Pages root category.

• Selection Pane listing: A reference to the page is added to the VertigoXG Palette’s 
Selection pane using the page’s name. The pages are listed in the Selection pane in 
alphabetical order. In addition to the page’s name, the page’s default keyer value is 
also listed.
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Adding a page to the VertigoXG palette
When creating a new page from a template, you will finish creating the new page by 
clicking the Save Page button. The Save Page button saves the new page to the Xmedia 
Server and adds a reference listing of the page (a page element) in the VertigoXG Palette’s 
Selection pane.

Pages added to the Selection pane are listed alphabetically and consist of the page’s name 
and its current default keyer value.

In reality, this listing is a reference to the page stored on the Xmedia Server. Therefore any 
changes saved to the page on the Xmedia Server are reflected in the page when it is 
opened from the Selection pane.

Pages can only be added to the Vertigo XG Palette’s Selection pane by first opening the 
template/page in Edit view and then clicking the Save Page button. Adding a page is not 
permitted in the VertigoXG Viewer’s Browse view.

Opening and editing an existing page in the VertigoXG Viewer
You can use the VertigoXG Viewer to edit existing pages that are saved on the Xmedia 
Server. Although there are various ways in which you can open the VertigoXG Viewer in Edit 
view, we recommend that you first add the page to the VertigoXG Palette’s Selection pane 
and then open and edit the page from this state. 

Note: While pages already exist on the Xmedia Server, you cannot create a 
new page from an existing page. In other words, there is no “Save Page As” 
functionality in the VertigoXG Viewer. You can only edit and save existing 
pages or create new pages from templates.

To open and edit an existing page using the VertigoXG Viewer:
1 Open the page in the VertigoXG Viewer’s Edit view.
2 Double-click the page’s name listed in the VertigoXG Palette’s Selection pane.

The page opens in the VertigoXG Viewer.

Note: If the page does not open and an error message appears, verify the 
Server settings, the operational state of the Xmedia Server and/or whether 
the page still exists on the Xmedia Server.

3 Optional: Edit the page’s dynamic fields. 
You may want to edit text fields, make selections from a drop-down list, or substitute 
an image, cel animation or clip asset displayed on the page.
To substitute an image, cel animation or clip element on a page, right-click on the 
element. A browser for that asset type appears and displays the assets on the Xmedia 
Server that can be used as substitutes. Select a new asset and click OK to add it to the 
page.
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Note: Changes to a page’s content will be saved to the Xmedia Server when 
you click Save Page. The page is a shared page, which means that saved 
changes will be reflected in all XG events that are already scheduled and 
associated with the page.

4 Optional: Edit the page’s default Duration value.
Changes to a page’s default Duration value will be saved to the Xmedia Server when 
you click Save Page. As such, these changes will be reflected the next time you add the 
page to an XG event. The duration value of XG events that are associated with the page 
are not affected by changes to the page’s default Duration value.

5 Optional: Edit the default Keyer value. 
Changes to a page’s default Keyer value are automatically reflected in the VertigoXG 
Palette’s Selection pane when you click Save Page. 
Note that the default Keyer value is not saved with the page asset on the Xmedia 
Server. However, the page’s reference in the VertigoXG Palette holds the new keyer 
value, so that when you open the page from the Selection Pane or add the page to a 
new XG event, the new default Keyer value is used. 

Note: Changing the default Keyer value does not affect the current Keyer 
value of XG events already listed in the ITX schedule.

6 Optional: Edit the default Trigger or Duration mode settings. 
Changes to a page’s default Trigger or Duration mode settings are not saved with the 
page asset on the Xmedia Server when you click Save Page. 

Note: Changing the default Trigger or Duration mode settings does not 
affect the current XG events already listed in the ITX schedule.

7 Click the Save Page button to commit any changes to the page. 

Adding an unedited scene to the VertigoXG palette
If a scene that is stored on the Xmedia Server is intend to be played out on air “as is” (does 
not require any edits), then we recommend using the following procedure to add the scene 
to the VertigoXG Palette’s Selection pane.

Making no edits to the scene allows you to add the scene to the Selection pane using the 
scene’s original name and content (as saved on the Xmedia Server). However, making edits 
and then clicking the Save Page button, creates a new scene asset, which is given a unique 
name, saved on the Xmedia Server and added to the Selection pane. See Creating a new 
scene based on an existing scene, on page 27 for more information.

To open and add an existing scene to the VertigoXG Palette’s Selection pane:
1 Click the Add Page button in the VertigoXG Palette to open the VertigoXG Viewer.
2 Browse the Scene category in the VertigoXG Viewer’s Asset Browser.
3 Double-click the scene to open it in the VertigoXG Viewer’s Edit view.
4 Do not edit the scene’s content (dynamic elements) or the default Duration value.
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Editing the content and/or the Duration value results in the creation of a new scene 
asset when the Save Page button is clicked, rather than applying the edits to the 
original scene.

5 Optional: Edit the default Keyer value. 
Changes to a scene’s default Keyer value are automatically reflected in the VertigoXG 
Palette’s Selection pane when you click Save Page. 
Note that the default Keyer value is not saved with the scene asset on the Xmedia 
Server. However, the scene’s reference in the VertigoXG Palette holds the new keyer 
value, so that when you open the scene from the Selection pane or add the page to a 
new XG event, the new default Keyer value is used. 

Note: Changing the default Keyer value does not affect the current Keyer 
value of XG events already listed in the ITX schedule.

6 Optional: Edit the default Trigger or Duration mode settings. 
Changes to a scene’s default Trigger or Duration mode settings are not saved with the 
scene asset on the Xmedia Server when you click Save Page.

Note: Changing the default Trigger or Duration mode settings does not 
affect the current XG events already listed in the ITX schedule.

7 Click the Save Page button to commit any changes to the scene. The scene is 
automatically added to the VertigoXG Palette’s Selection pane.

Note: After the scene has been added to the Selection pane using the Save 
Page button, the scene remains open in the VertigoXG Viewer. Any edits that 
are made to the scene while it’s open in the VertigoXG Viewer will apply to 
the scene that was just added to the Selection pane. When the Save Page 
button is clicked, the changes will be saved to the current scene without 
creating a new scene.

Updating a scene already listed on the VertigoXG palette
If you want to update the content elements or properties of an existing scene asset, 
without creating a new scene asset, you must open the scene from the VertigoXG Palette’s 
Selection pane. Once you have made the necessary edits, clicking the Save Page button 
saves the changes to the scene asset on the Xmedia Server and updates the scene’s listing 
on the Selection pane.

To open and apply edits to an existing scene:
1 Double-click the scene’s name in the VertigoXG Palette’s Selection pane.

The scene opens in the VertigoXG Viewer’s Edit view.
2 Optional: Make changes to any of the scene’s dynamic content elements (e.g. change 

text or substitute image, clip or cel animation elements).
3 Optional: Edit the scene’s default Duration value.

Changes to a scene’s default Duration value will be saved to the Xmedia Server when 
you click Save Page. As such, these changes will be reflected the next time you add the 
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scene to an XG event. The duration value of XG events that are associated with the 
scene are not affected by changes to the scene’s default Duration value.

4 Optional: Edit the default Keyer value. 
Changes to a scene’s default Keyer value are automatically reflected in the VertigoXG 
Palette’s Selection pane when you click Save Page. 
Note that the default Keyer value is not saved with the scene asset on the Xmedia 
Server. However, the scene’s reference in the VertigoXG Palette holds the new keyer 
value, so that when you open the scene from the Selection pane or add the page to a 
new XG event, the new default Keyer value is used. 

Note: Changing the default Keyer value does not affect the current Keyer 
value of XG events already listed in the ITX schedule.

5 Optional: Edit the default Trigger or Duration mode settings. 
Changes to a scene’s default Trigger or Duration mode settings are not saved with the 
scene asset on the Xmedia Server when you click Save Page. 

Note: Changing the default Trigger or Duration mode settings does not 
affect the current XG events already listed in the ITX schedule.

6 Click the Save Page button to commit any changes to the scene. The edits are saved on 
the Xmedia Server and the scene is automatically updated on the VertigoXG Palette’s 
Selection pane.

Creating a new scene based on an existing scene
The VertigoXG Viewer provides you with a “Save As” type functionality that allows you to 
create a new scene asset from an existing scene asset. The new scene is given a unique 
name, saved on the Xmedia Server and added to the Selection pane.

To create a new scene asset based on an existing scene:
1 Click the Add Page button in the VertigoXG Palette to open the VertigoXG Viewer.
2 Browse the Scene category in the VertigoXG Viewer’s Asset Browser.
3 Double-click the scene to open it in the VertigoXG Viewer’s Edit view.
4 Make changes to any of the scene’s dynamic content elements (e.g. change text or 

substitute image, clip or cel animation elements).
5 Edit the scene’s default Duration setting.

Changes to a scene’s default Duration value will be saved to the Xmedia Server when 
you click Save Page. As such, these changes will be reflected the next time you add the 
scene to an XG event. The duration value of XG events that are associated with the 
scene are not affected by changes to the scene’s default Duration value.

6 Optional: Edit the default Keyer value. 
Changes to a scene’s default Keyer value are automatically reflected in the VertigoXG 
Palette’s Selection pane when you click Save Page. 
Note that the default Keyer value is not saved with the scene asset on the Xmedia 
Server. However, the scene’s reference in the VertigoXG Palette holds the new keyer 
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value, so that when you open the scene from the Selection pane or add the page to a 
new XG event, the new default Keyer value is used. 

Note: Changing the default Keyer value does not affect the current Keyer 
value of XG events already listed in the ITX schedule.

7 Optional: Edit the default Trigger or Duration mode settings. 
Changes to a scene’s default Trigger or Duration mode settings are not saved with the 
scene asset on the Xmedia Server when you click Save Page. 

Note: Changing the default Trigger or Duration mode settings does not 
affect the current XG events already listed in the ITX schedule.

8 Click the Save Page button. 
A new scene asset is created, saved on the Xmedia Server and added to the Selection 
pane. The new asset is given a unique name, which consists of the name of the original 
scene with the date and time appended. If the original scene already had a date and 
time in its name, the date and time will be replaced.

Note: After the new scene has been added to the Selection pane, the scene 
remains open in the VertigoXG Viewer. Any edits that are made to the scene 
while it’s open in the VertigoXG Viewer will apply to the scene that was just 
added to the Selection pane. When the Save Page button is clicked the 
changes will be saved to the current scene without creating a new scene.

Adding XG Events to an iTX schedule
XG events are secondary events in a schedule that allow Vertigo graphics pages and scenes 
to be played out on a specified keyer layer. 

You can add XG events to the iTX channel’s schedule by either adding a page or scene to 
the Schedule Grid or to the Timeline.

The VertigoXG Palette uses the term “Page” for both Vertigo pages and scenes. For example, 
the Selection pane lists both pages and scenes, but the column heading is Page Name. 

Adding an XG Event to the Schedule Grid
Once pages (Vertigo page and/or scene assets) are listed in the Vertigo XG palette, you can 
drag a page/scene from the Selection pane directly onto a primary event on the channel’s 
Schedule Grid. This adds the page/scene as a secondary event of type XG. The page/scene’s 
default duration value and default keyer value are used for the event’s Duration and Keyer 
settings, but they can be edited directly in the Schedule Grid or using the Event Editor (see 
page 29).

Adding an XG Event to the Timeline
In order to add a page/scene to the timeline, the timeline grid must be configured to 
display the XG keyer tracks. Selecting the Select Tracks button above the iTX Desktop’s 
timeline allows you to select and display the XG Keyer tracks in the timeline. 
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Once the XG Keyer tracks are displayed on the timeline, you drag & drop a page/scene from 
the Vertigo XG palette’s Selection pane onto the primary video track on the timeline. The 
page/scene is added to the appropriate XG keyer track as determined by the page/scene’s 
keyer setting.

Editing the properties or content of a scheduled XG Event
When a page or scene is added to the iTX channel’s Schedule Grid as an XG event, some of 
the event’s properties, like Duration and Keyer, are initially set using the page/scene’s 
default values. 

You can edit the XG event’s properties by selecting the XG event’s row in the schedule and 
then selecting the Event Editor tab. The event’s properties can be edited directly in the 
Event Editor and the changes applied by clicking the Store Changes button. 

Clicking the Edit Page button opens the page/scene in the VertigoXG Viewer’s Edit view. 
You can make content changes to the page that is currently assigned to the XG event. Once 
you have clicked the VertigoXG Viewer’s Save Page button, changes to the page/scene are 
applied to the page/scene asset on the Xmedia Server, as well as to all XG events that are 
associated with that page/scene, even in other channel’s schedules.

Note: When an older schedule is loaded into the iTX Desktop, it may contain 
XG events that were authored using an older version of the VertigoXG plugin. 
If the Edit Page button is clicked for an older XG event, it will open the Edit 
page fields dialog, which only allows editing of text substitutions in a grid.

.
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Contact Us
Grass Valley Technical Support
For technical assistance, contact our international support center, at
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s website (www.grassvalley.com).

An online form for e-mail contact is also available from the website.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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